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JT exportieren

Version: UNIGRAPHICS/NX 7.5 Ersteller: Christoph Maier

Beim Exportieren in das JT-Format gibt es verschiedene Einstellungen, , )
iber die man steuern kann, was alles exportiert wird. Diese Datél>Exportieren
Einstellungen kann man unter Vorseinstellungen > JT oder in der >JT
Konfigurations-Datei vornehmen. Nicht alle Einstell-Moglichkeiten sind

an beiden Stellen vornehmbar!

Die untere Abbildung zeigt die Konfigurations-Datei, welche im
Installationsverzeichnis ...\UGS\NX7.5\PVTRANS zu finden ist.

1 werzion "EAITranslator”™ 1.0.0 "EAITranslator”
2 EAITranslator {
3 Outputlirectory =
4 CommonPartskath =
; o o 43 LOD 737 |
5 chordalOption = "RELATIVE a Level = 3
3 structurelption = "PER_PART" a5 Chordal = 0.01
7 writeWhichFiles = "ALL"™ a5 Angular = 0
& punilption = "PART AND ASM" 7 Length = 0
a JtFileFormat = a7 43 Fz.aatuFeSupprEsslnn =0
. . 43 Simplify = 0.1
1o triftriplpt = true 1) AdvCompressionlewvel = 1
11 seaniewing = false 51}
1z seamfewingTol = 0.00L1 52 ugConfig {
13 includeBrep = true L= doWirsframe - false|
L 54 mergeihests = true
14 autolamefanitize = true )
55 mergesolids = true
15 updateChangedPartsinly = false | 56 checklayers = false |
1a wverboseReporting = false 57 XThrep = true
17 writehsciidkssembly = false 58 appendRefsetliane = false
. 59 tAttributs = fal
15 zinglePartsNokssen = falae L 2= LIIRRES alse |
. &0 appendItenlane = True
13 autoLowLiDgeneration = true 61 appendRevision = true
20 smartL0Dgeneration = false 62 excludeViaRefiet = false
21 nunlLiDs = 3 63 usePreferredRefiets = false
2% ! 6 Spotieldiize = 1
) 65 activateNotePMI = false
23 Filter { 1) activateCsysPNI = false
24} 67 activareleldPHI = false
25  Metadata | 6d activateMpawPMI = false
26 ) 63 activateGDTPMI = false
27 LOD *17 { 70 activateFosPMI = false
71 activateDinPMI = false
28 Level = 1 72 activateSyubolPNI = false
29 Chordal = 0,001 73 activateSupplenentalGeonPMI = false
a0 Angular = 20 74 applyPMIRefset = false
31 Length = 0 ] confiqureleafNodeNane = false
) 76 configqureFileName = falze
e AdvCompressionlevel = 0 77 includeTnwisible = false
33} 78 LogReporting = “"ERROR,WARNING, INFO©
34 LoD Tz o 79 ConsoleReporting = "ERROR™
35 Level = 2 80 LogFileName = "UG_PART"
&l uszeRefsets = "DEFAULT™
36 Chordal = 0.0035
g2 getCADFroperties = "CAD DENSITY,CAD MATERIAL,CAD MASS™
37 Angular = 0 | IEE advancedMaterials = false |
35 Length = 0 S dodection¥iews = false
i FeatureSuppreszion = 0 85}
40 Simplify = 0.4
41 AdvCompressionkevel = 0.5
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1 PMI

1 PMI
Start > PMI Um auch PMI's zu exportieren, muss in der Konfigurationsdatei der
PM| > entsprechende Eintrag aus unten stehender Tabelle vorgenommen
werden.

PMI | Informationen Analyse Vore

Bemabung 8 PMI: Konfigurationsdatei:
B, Hinweis.. Ermittelte Bemalung
j"‘ Form-/Lagetoleranzrahmen... HOI‘iZOﬂtale BemaBUng
; Bezugsselementsymbol... Vertikale BemaBUng
~ Bezugsziel. Parallele Bemaf3ung
;j Oberfliche schlichten... Senkrechte BemaBUng
" Schweilsymbol (2D)... b B
& |D-Symbol {Kreis)... Fal'sen ema Ung

. WinkelbemaRung

Symbo 3 . .

. _ Zylindrische Bemal3ung

Erganzungsgeometrie 3

A — R Bohrungsbemallung

Sicherheitsmarkierung 3 DUrChmesserbemaBUng . X

. activateDimPMI = true
Schnitt v RadiusbemalRung

Bemaf3ung Radius zu Mittelpunkt
Verkirtzte Radiusbemaf3ung
Dickenbemal3ung
BemalRung der Bogenlange
Horizontale Kette
Vertikale Kette
Horizontale Grundlinie
Vertikale Grundlinie
Steigende Bemal3ung
Hinweis
Textblasenhinweis
Allgemeiner Hinweis
spezifischer Hinweis
Koordinatenhinweis
Unternehmensidentifikation
Materialspezifikationen
Teilidentifikation
Prozessspezifikation activateNotePMI = true
URL-Hinweis
Anwenderdefiniert
Zeichenfolgenhinweis
Notiz-Nummer
Notiz-Ganzzahl
Behdordensicherheitsinformation
Eigentumsbezogene Informationen
Exportkontrolle
Form-/Lagetoleranzrahmen
Bezugselementsymbol activateGDTPMI = true
Bezugsziel
Lokalisiererbezeichnung
Oberflache schlichten
Anwenderdefiniertes Symbol
SchweiRsymbol
PMI-Bereich

Mittelpunktmarkierung activateSupplementalGeomPMI = true
3D-Mittellinie

activateSymbolPMI = true
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Bezugskoordinatensystem,
Bezugsachse, Bezugsebene, activateCsysPMI = true
Bezugspunkt

Hinweis:
Damit die Bemal3ung eines symbolischen Gewindes nicht ,in der Luft
hangt®, sollte man auch die gestrichelte Linie dazu exportieren:

doWireframe = true (Kurven, auch Skizzen-Kurven, werden exportiert)
Damit die PMI's in JT2Go angezeigt werden:
Tools > PMI aktivieren und im Grafikfenster <MB3> auf das Teil > Toggle

in PMI Tree;
Sie werden dann im PMI-Navigator aufgelistet.

| |
v Assembly | B Snapshots  [Z] PMI H

Tipp:

In JT2Go in den Voreinstellungen zu den PMI's den Haken Link PMI
visibility to part visibility setzen, dann wird Automatically turn PMI on
wéahlbar. Der zweite Haken bewirkt, dass PMI's automatisch in JT2Go
angezeigt werden.

Per-Type Defaults | Global Settings | Mouse | Datum Symbols | Coordinate Systems | Palette

Selection Color

PMI color: I Invalid PMI:

Geometry color: _ |v

Geometry width:
Visibility

Show non in-plane labels | Show Al ~ [T] Show out-of-orientation indica
I Link PMI visibility to part visibility I I:N.rtomaticalh'tum PMI on I

T

Tipp: PecTpe Detote i
Mit der Einstellung Flat-To-Screen passen | = ™" (ot St Wowre | Do
sich die PMI's der Ansicht dynamisch an. —— ® Fit-To-Screen
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1 PMI

=HPMI
L+ HE [ 45_zahnwelle_NX7_5
ﬁWDimension
IR Dimension (1)
ﬁWDimension (2)
ﬁWDimension (3
@WDimension 4)
ﬁWDimension (5)
I Dimension (5)
ﬁWDimension 7
> W Note
L = @Note (9)
=+ Mode! Views
(595 17 45_zahnwelle_NX7_5

= B (O "Back”
ﬁWDimension (N
* [@Note (9)

= B (O "Bottom”
«EIF Dimension (1)
[ Note (9)

& O "Frort”

PMI > Preferences
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2 Material

;!
=

Werkzeuge >
Materialien >
Materialien
zuweisen

Seite 4/9

o

2 Material

Weist man einem Solid ein Material
zu, so wird dieses exportiert. In
JT2GO kann man Uber <MB3> auf
Eigenschaften

den Solid

die

(Properties) anzeigen lassen:

%

ass_fixierdeckel_SOLIDS
Fit: &ll

View Only

Fly ko Part

Turn OFf
Seek
Select

Select Al

Froperties. ..

Properties
Attributes
Altribute | W alue
AdvCompressLODLevel: 0.000000 0.500000 1.000000
CAD Source: Unigraphics M [internal]
CaD_DEMSITY:
CAD_Mas5: 1.6764
CAD_MASS_UMITS: kilograms
CaD_MATERIAL:
JT_PROFP_MEASUREMEN...  millimeters
Mame: model1_SOLIDS
Translation D ate: 2011412/08-15:28:49
Trarslatar Yersion: MK 7.5.2
Frint | E xport Ta File |

0K | Abbrechen |

3 Material in Studio

Wird einem Solid per

Drag

& Drop ein

Properties

Aftributes
Attribute | Walue |
AdvCompressLOD Level: 0.000000 0.500000 1.000000
CaAD Source: Unigraphics M [internal]
CaD_DENSITY: 2.711e-006
CaD_MaSs: 0.00132658
CAD MASS LIMITS: kilograms
CaD_MATERLAL: Alurninum_E0E1

| _| ' | ... milimeters
Marme: azz_fiierdeckel_SOLIDS
Tranzlation D ate: 2011/412/08-15:43:.08

Translatar Yersion: M 752

Frint | Export Ta File|

0K | abbrechen |

Wurde ein Material zugewiesen, so
wird beim Exportieren auch die
entsprechende Dichte ~mitge-
nommen®“. Ansonsten wird fur die
Dichte der Wert aus den
Voreinstellungen ibernommen.

Befinden sich in einem Part
allerdings zwei oder mehr Solids,
erhalt man keine Informationen zu
Material und Dichte.

Die Masse wird immer mit exportiert.

Material aus den

Systemmaterialien zugewiesen, wird dieses mit der nachfolgenden
Einstellung in der Konfigurationsdatei ins JT exportiert:

advancedMaterials = true

Der Solid wird unschattiert exportiert. D.h., das JT enthalt Texturen und
damit auch Unebenheiten, Muster, Transparenz und Lichteffekte.

© 1999 - 2013 HBB Engineering GmbH - All rights reserved



&

LJ
>

Name [sandstone

Texturgréfe
Bildmodus
[ HaiBumps verwenden

Kachel @

[“JFormschattierung in Advanced Studio deaktivieren

JiE
[z 4

[ Texturraum

Unebenheite:

n

[Rauh (ur )

_..D—
@

Abbrechen

Achtung:
Die Materialien werden nur exportiert, wenn beim Exportieren die

Studio-Anzeige aktiv ist!
Damit bei einer Baugruppe die Materialien ins JT exportiert werden,
mussen die Materialien im Einzelteil zugewiesen werden!

4 Wahre Schattierung
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Die rechte Abbildung zeigt das exportierte JT-File in JT2GO.

Die Wahre Schattierung wird nicht exportiert.

3 Material in Studio
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5 Objektdarstellung

i

Bearbeiten >
Objektdarstellung

Seite 6/9

5 Objektdarstellung

Layer:

Allgemein | Analyse

% | Objektdarstellung bearbeiten X

Basissymbol

Layer
Farbe
Linientyp

Ereite

Schattierte Anzeige

1
—
[Ya
——

Durchsichtigkeit
0

0

o

DFIa'chenanalyse

DTeilweise Schattiert

100

_ nur Objekte auf aktiven Layern werden
checkLayers = false .
exportiert
_ nur Objekte auf dem Arbeits-Layer werden
checkLayers = true :
exportiert

Wird beim Einzelteil immer mit exportiert

Farbe

In Baugruppen wird die Farbe des
Einzelteils exportiert. Wurde dem Teil in der
Baugruppe eine Farbe zugewiesen, wird
diese ignoriert.

Linienfarbe

Wird immer exportiert (Die Farbe der
Kanten kann in JT2GO festgelegt werden:
View > Preferences > Display)

Linientyp

Wird immer exportiert

Breite

Wird nicht exportiert, kann aber in JT2GO
eingestellt werden (View > Preferences >
Display)

Wird beim Einzelteil immer mit exportiert

Durchsichtigkeit

In Baugruppen wird die Durchsichtigkeit des
Einzelteils mit exportiert. Wurde die
Durchsichtigkeit des Teils in der Baugruppe
festgelegt, wird dies ignoriert.

Teilweise Schattiert
Flachenanalyse

Wird nicht exportiert
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6 LOD (Level Of Detail)

Kann in NX unter Voreinstellungen > JT > Mosaik oder in der
Konfigurationsdatei eingestellt werden und gibt die Oberflachengite im

JT-Format an.

Seitlich (Chordal)

Winkel (Angular)
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(Abbildungen aus der Online-Hilfe)

Metadats |

w | JT-Konfiguration 3 }
Mosaik | NX-Objekte LoD "17 §

Seitlicher Wert Level 1
®Relativ () Absolut Chordal = 0.001
Anogular = 20
Genauigkeit Length = O
Anzahl Stufen AdwCompressionLlewvel = 0
[¥f) Zus&tzliche Ebenen fiir schnelleres Rendem ¥
[")Ebenen fiir glétteren Ubergang anpassen LoD mam o
Level = 2
LOD ™17 | LOD "2"| LOD "3 Chordal = 0.0035
seitlich 0.0010 Angular = 0
- Length = 0O
Winkel 20.0000
Featureluppression = 0
Lange 0.0000 Simplify = 0.4
Vereinfachen 0.0000 AdvCompressionLevel = 0.5
Formelementunterdriickung 0.0000 }
rr rr
Bezeichnung :] Lop 3oy
00 Level 3
Erweitertes Komprimieren D Chordal = 0.01
oo Angular = 0
Niedrig Hoch
Length =
Featureluppression = 0
[0k ][ auick |[ Abbrechen Simplify = 0.1

AdwCompressionLlevel =

6 LOD (Level Of Detail)
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7 Baugruppe:

X [Komponente verschieben [oT=T%

Zu verschiebende Komponenten | A

+ Komponenten auswahlen (1) i

Transformation | A

Kopieren | A

[mm

Einstellungen

]
/ [
[z so000]
Femm

Die Postion der Komponenten einer Baugruppe bleiben im JT erhalten.

Explosionsansichten werden exportiert, dabei kann folgendes Verhalten
beobachtet werden:

Wurde eine Explosionsansicht erstellt (egal in welcher Ansicht), wird sie
immer exportiert. Das gilt auch, wenn die Arbeitsansicht eine
Modellansicht ist, bei der die Explosionsansicht nicht aktiv ist.
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8 Attribute:

8 Attribute:

Attribute, wie zum Beispiel der Name (hier: Zylinder_gedreht.prt) einer
Komponente, werden immer exportiert und kénnen im JT2GO uber
<MB3> > Properties angezeigt werden.

Properties = %]
Athibites |
| Byribnge | vahe |
|‘AdvCompress 0D evel 0000000 0 500000 1,000000
|HE|\'-‘AF|!3E!_=LJNE DIF;hEﬂ. ;
Bei selbst erzeugten Attributen e L ey
i i iten: CAD_MASS: rEL
(in diesem Fall Bearbeiten: ERDeHARE s i
Drehen), muss die _Conf|g-Date| JT_PROP_MEASUREMEN... milmeters
JT_PROP_ORIGINATING . %THrep
angepasst werden: e % ncer 3o SO00)
: Tianslaton Dale 2071 A 2/0510.07 59
getAttributes = true. Tranclator Version: <752
Pit | Expui ToFie|
OK | Abbrechen |

Die .prt's werden wie folgt exportiert:
NX 6 >JT Version 9.0
NX 7.5 > JT Version 9.0
NX 8 > JT Version 9.5
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